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Abstract

Planning and managing a research are vital part of your PhD
journey. At the beginning of the research, it seems “there Is
Infinite time to handle the research”. But, when students reach
to the dead line, they may discover that many things should be
done. Students should know, What do | want from my PhD?,
and What should | do now/next?. In this workshop, Dr. Nader
use some Research Tools for managing and planning a
research. The Research Tools enable researchers to follow the
correct path in research and to ultimately produce high-quality
research outputs with more accuracy and efficiency.

Keywords: H-index, Improve citations, Research tools, Bibliometrics,
Research visibility, Research impact



Do Research,
Don't Re-Search
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Research Tools Mind Map

Web of Science

SCOPUS
EndNote

ol 51 Virtual Teams will become as important as |
OATD

& many more Research Tools

dtSearch H

SpringerExemplar ‘

Q|qqa . - R esearch
Academic Phrasebank
& many more tools

(1) Searching the literature =

Research Tools
- —
4 By: Nader Ale Ebrahim B

Journal Citation Reports
Journal Metrics
. (@ Enh. Manuscript matcher

s
N

. ] ) i~ *g, (3) Targeting suitable journals =
Find the perfect journal for your arti - I\!F‘#x’-“?j’“ [~ :
& many more Research Tools “
393.7k views
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https://www.mindmeister.com/39583892/research-tools-by-nader-ale-ebrahim
http://www.mindmeister.com/39583892/research-tools-by-nader-ale-ebrahim
https://pixabay.com/en/books-stack-learn-study-library-1015594/
http://fotomelia.com/?download=homme-bureau-ordinateur-images-gratuites
https://pixabay.com/en/discussion-session-white-male-1874791/

Session Topic

Introduction
Selecting keywords
Finding Research Papers

Evaluate a paper quality

&> w0

Managing Research

-

Read a paper
Indexing Desktop Research Tools

Avoid Scientific Misconduct

O 0 N O E

Writing a Paper
10. Improve paper quality
11. Target Suitable Journal

12. Improve your Research Visibility and Impact

Research Visibility and Impact Center-(RVnIC)
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Tasks for the first session

1. Structure & planning your research (Draw the
literature map)

2. Read:

e https://www.dlsweb.rmit.edu.au/Isu/content/2 AssessmentTasks/assess tuts/
lit review LL/reading.html

» Cottrell, S. (2005). Critical thinking skills - Developing Effective Analysis and
Argument. Basingstoke: Palgrave Macmillan.

* Chapter 3 of “Creswell, J. W. (2012). Educational research: Planning,
Conducting, and Evaluating Quantitative and Qualitative Research (4th ed.).
Boston: Pearson Education, Inc”

* Chapter 3 of “Saunders, M., Lewis, P., & Thornhill, A. (2009). Research methods
for business students (5th ed.). Edinburgh Gate, Harlow, Essex CM20 2JE,
England: Pearson Education Limited.”

Research Visibility and Impact Center-(RVnIC)
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https://www.dlsweb.rmit.edu.au/lsu/content/2_AssessmentTasks/assess_tuts/lit_review_LL/reading.html
Link/Critical Thinking Skills Developing Effective Analysis and Argument.pdf
Link/Educational Research.pdf
Link/RM Saunders.pdf

Tasks for the second session

Create the log file for your search term/s

Identify the main keywords set for your research
Identify the alternative keywords set for your research
Evaluate the search terms

Looking for selected keywords sets on:

v SCOPUS

v Web of Science Core Collection

Write the methodology used for selecting the final keywords set



Tasks for the third session

1. Install a reference management

software

2. Download selected papers (based on the
final keywords set) into the reference

management software



Tasks for the fourth session

1. Measure the downloaded papers/journal’s quality

2. Rate the downloaded papers in your Desktop
Endnote library

3. Turn on Alert system in Scopus, WoS and other

databases based on the selected papers



Outline

_ Microsoft OneNote

_ Reference Management tools
_ Core Papers, Shell papers, Filler papers

I Mind Map Tools

_ How to Manage a PhD Thesis

Research Visibility and Impact Center-(RVnIC)
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Project cycle, research process, scientific paper

New knowledge
technology information

Analysis of data

Interpret results

Draw conclusion

Source: https://cgspace.cgiar.org/bitstream/handle/10568/963/Scientific20Writing-Mahider.pdf

Target group identification

Problem identification

Research question

Collection of background information

Clear definition of problem and causes

¥

Defining purpose and objective

.

Deciding on the interventions
activities methodology

—Scientific Paper——
Results Introduction
Analysis Background
Interpretation Literature Review
Discussion Research Gap
Conclusion Goals
Implications Pur_po_s{_z i
Limitation Objectives
Materials
Methods

Design options

Collecting data

Monitoring

Planning

Research Visibility and Impact Center-(RVnIC)
©2019-2021 Dr. Nader Ale Ebrahim
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https://cgspace.cgiar.org/bitstream/handle/10568/963/Scientific%20Writing-Mahider.pdf

#

Source: https://www.uos.ac.uk/content/reflections-and-tips-%E2%80%98living%E2%80%99-and-%E2%80%98managing%E2%80%99-your-phd

Research Visibility and Impact Center-(RVnIC)
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https://www.uos.ac.uk/content/reflections-and-tips-%E2%80%98living%E2%80%99-and-%E2%80%98managing%E2%80%99-your-phd

Microsoft OneNote

OneNote 2007 Basics - OneNote ?

Insert Draw  History Review View Nader Ale Ebrahim

B X Cut —

[ B Copy == = Heading 1 The Best Word (Ctl+1 EQ H

Methodology (Ctrl+2] -

.
|
4
i
4

il

Paste o Format painter | B 1 U abe x, - | =-|X To Do (Ctrl+3) s T?azo ;:;i ir:ga:

Clipboard Basic Text Styles Tags Email ~
i::l Toolkit - Using OneNote 200... v | Welcome Basics ~ Collaboration = Distribution =~ Examples =~ New Section 1 + Search (Cul+B) L~

2 (*) Add Page
OneNote 2007 Basics
Wednesday, March 19, 2008 4:17 PM = Welcome
Getting Started
OneNote 2007 Basics
¥ Table of Contents
How are OneNote pages different? Ol eefivl ) ey Quziteit= 2T0Y

This is an example of a normal page of notes. You can type anywhere — just click and type. For example, type your name here.
Then try moving it around.

- Nader Ale Ebrahim

There is no Save button on the toolbar because OneNote saves all your notes automatically! Worried you might lose
something? OneNote backs up all your information. You can open your backup at anytime with File > Open Backup. You
can also change where and how often we backup your information in Tools > Options in the Backup section.

What are all the tabs?
OneNote is a place for gathering, organizing, searching, and sharing notes, clippings, thoughts, reference materials, and other

information. All your notes will be visible here — organized by notebooks, sections, and pages. You can create them by clicking
File > New.

Research Visibility and Impact Center-(RVnIC)
©2019-2021 Dr. Nader Ale Ebrahim 14



Zéj.;fj,_;_ : THOMSON REUTERS I

Btbhographies Made Easy .

FPENDELEY

RESEARCH NETWORKS

zotero

N3 qiqga
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http://endnote.com/
http://www.mendeley.com/
https://www.zotero.org/
http://www.qiqqa.com/

= Qiqqga

% Home (F1) [& aleebrahim's Library X% @ Expedition %

-
Library for Expedition: =
aleebrahim's Library Refresh
Expedition

You haven't refreshed your Expedition for this library for a while. If you have add new papers or tags to your library, you may wish to press the Refresh button on the toolbar. It will run in the background so that you

can keep working.

1. The; risk; Risk; M=

76% - (2018) CREDIT RISK MANA
69% - (2017) The exposure of mit
68% - (2018) Endogenous scope

55% - (2018) Do natural catastroy
52% - (2018) Credit risk in microf
44% - (2018) Capturing Risks and
37% - (2016) Rational Herding to
36% - (2015) Agent-Based Mappi
35% - (2017) Risk management p
29% - (2016) Performance of Mic

Show me more

Show me in Brainstorm

2. The; Social; MFI =

70% - (2017) Why do microfinanc
68% - (2017) The access of micro
64% - (2018) Microfinance Perfor
59% - (2017) Sustainable Microfir
53% - (2015) The Impact of Socia
50% - (2016) A social and enviror
47% - (2015) Practice What You F
41% - (2015) Microfinance Institu
36% - (2016) ARE FINANCIAL AN
-

: @ -
« Number of themes: ./ Use AutoTags? - —

=13 ' Use Tags? Refresh Manage Export Tutorial
AutoTags AutoTags Themes

Microfinance institutions’ website accessibility
2018 Tadele, H. and Roberts, H. and Whiting, R. H.
Pacific-Basin Finance Journal

279 (1/15)

Pacific-Basin Finance Journal 50 (2018) 279-293

Contents lists available at ScienceDirect

Pacific-Basin Finance Journal

journal homepage: www.elsevier.com/locate/pacfin

% _ [PACIFIC
= | BASIN

Themes in this document = Documents relevant to this one

52% - (2015) Audit Quality and Corporate Governance: Evidence from the h
47% - (2015) Determinants of the governance quality of microfinance instit
47% - (2017) Does Religious Affiliation Influence the Design of Corporate G
47% - (2017) Why do microfinance institutions fail socially? A global empiri
46% - (2017) The access of microfinance institutions to debt capital: An em|
45% - (2018) Microfinance Performance and Social Capital: A Cross-Country
43% - (2017) Sustainable Microfinance and Global Performance Proposal fo
41% - (2015) The Impact of Social Beliefs on Microfinance Performance by |
40% - (2016) A social and environmental approach to microfinance credit s

8. The; governance; MFls; microfinance; financial

Research Visibility and Impact Center-(RVnIC)
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Properties = Annotations = Preview

Tweet This

@Qigqa InCite, the best
o referencer manager there is.

Practically writes your paper

Abstract

279 (1/15)

280.(2/15)
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Filler papers = 150

Research Visibility and Impact Center-(RVnIC)
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Nader’s role:

How Many References Should I Include in a
Literature Reviews Paper?

From all available papers in your field of study = 2000,
Include almost 200 papers:

1. Filler papers = 150
2. Shell papers = 30
3. Core papers < 20

Research Visibility and Impact Center-(RVnIC)
©2019-2021 Dr. Nader Ale Ebrahim




Mind Map Tools

\2h mindmeister;

#TEXT~MINDMAP,,

Spicynodes

/%

Source: Mind Map Tools, By:Seyyed Ali Fattahi Computer PhD Candidate FTSM UKM
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http://www.mindmeister.com/
http://www.spicynodes.org/
http://www.mindomo.com/
http://www.mindmaple.com/
Link/Mind Map Tools.pptx
https://tobloef.com/text2mindmap/
https://www.mindjet.com/
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Source: https://www.mindjet.com/
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https://www.mindjet.com/

Design patterns

Software design
Validation

Software
engineering

Software
product lines

Performance

Software
visualisation

Control theory

Scientific
visualisation

intelligence

~ Visualisation

Autonomics e

Self-* \

properties

I_nformation
visualisation

Human-
computer
interaction

Multi-modal
interfaces

Decentralisation

Zoomable user
interfaces

Ad-hoc
networking

Pervasive
computing

Mobile
computing

Sensor
networks

Source: Ross' PhD Literature Review Mind Map

Research Visibility and Impact Center-(RVnIC)
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http://pkab.wordpress.com/2009/05/22/peta-konsep-membantu-studi-literatur/

81 thesis.mm - SdPlore MindMapping - MindMap Mode C:\myliterature\thesis.mm

Fle Edt View Insert Format Navigate Tooks Maps SciPlore MindMapping Help

| Academic Search Engines
If i
‘,J_"EEEY".LCP»W_"E?S? o
| Digital Libraries
Web Search Engines

/ SEQ _

.’_\)
- A ic Search Engine Opti ion (ASEQ) was first introduced in 2010,

Academic search engine optimization (ASEO) is the
 d creation, publication, and modification of scholarly

O O o ¥ 100% > imEd|e e B9 i bo|#| ¢ D d = 4 =[sanssers =l =l
X A | thesismm |
g H
Q This would not exist if | had not received support from so many people.
? ;'f Above all, | am i tomy isor Prof. ABC, who was very generous with her time and
| _knowledge.

a / Ackowiadaement §- She me in each step of the dissenation in 3 way that went far beyond her duties.
. [ \__lalso express my to Prof. 123 who gave me advice in the beginning of my
g / \_ Forp ing and iding some ‘last-minute ideas’, | am grateful to x, yyy. zzz. and aaa.

/
v | postact
X [ / _ Background |
g [/ / Ranking Algorithms in General |
9
@
®
(6]
@
@

Deadli The:authors defined ASE0 22 4 in a way that makes it easier for academic
Oﬁf_a...l'l.ei»\ \ search engines to both crawd it and index it
;- Contacts £ inthe i 10 ASEO differs
i Related Work /
(}M — Some i ASEO 3s 3 legiti tool others as
o Instructions _negative
Publishers / 9

o | In my opinion, being interested in how (academic) search engines
| - function and how scientific papers are indexed and, of course,
| responding to these... well... circumstances of the scientific citing

) [ is Just natural
In the foliowig ate s0me { §i ASEO sounds good to me. | think it's a good idea

quotes from scholars on ASEQ } positive
Search engine optimization (SEQ) has 3 golden age in
- this internet era, butto use itin academic research, it
‘ sounds quite strange for me. After reading this publication
[ \ focusing on this issue, my opinion changed
\ \_ 8~ This definitely needs
\_Differences to SEO

|\

.“\, Methdology

||l;ﬂj\ \\ Implementation
B\ S0

1\
Resuns__o

i\
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\\\_Further Work

\
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\\Mo
\_Appendix__
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Source: https://www.scss.tcd.ie/joeran.beel/blog/2010/03/02/how-to-write-a-phd-thesis/
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How to Manage a PhD Thesis



Background
O

You have been recommended by your faculty to be a part of the Upskill Program team of
presenters to offer sessions on ‘Thesis Writing'.

Issue #9 Newsletter of the Society of Collaborative Networks (SOCOLNET)

YOUR THESIS ‘ User profiles for Luis M. Camarinha-Matos
IN 3 MINUTES® g 2iares

Luis M. Camarinha-Matos

V" Full Professor, New
A — University of Lisbon
Ve Verified email at

uninova.pt

Cited by 11427

Research Visibility and Impact Center-(RVnIC)

©2019-2021 Dr. Nader Ale Ebrahim 27


https://50b5c15d-a-268e1f8f-s-sites.googlegroups.com/a/uninova.pt/socolnet/newsletters/Socolnetnews9.pdf?attachauth=ANoY7cpBVjI9uMP1tbHit0e4wVL-rVb-TgTcbhCWB5LLmbvMXUCJm35Im0QnkO1GcjmcuX_eCYieLiekT8WEGXJN32M3GclrnuSj2Ncv2DGKmpy_KJ9Lov5XWnUj3mdMpfT3gsMgHIL71BTGxp3PJnNQ3fUD3JKAegKb7irimluwJDTNOMxgzIhHmuGwWbIfe6QCJKOmXMXqFdgnmNSm1MHgZT6xX2Z07G1LYmEX_Y6XeCwbFg9LUzY%3D&attredirects=0
Link/Socolnetnews9.pdf
Link/Um invitation to teach Thesis Writing 7-09-2012.pdf
http://scholar.google.com/citations?user=PniLEoUAAAAJ&hl=en
Link/EPD 2010_ 3 Minutes Competition - Nader.flv
Link/Nader - Viva.pptx
Link/Nader - Viva.pptx

MOTIVATION

If there is a better reason to paddle, | don't know what it is.




MOTIVATION

If there is a better reason to paddle, | don't know what it is.




No Shortcuts to a PhD!

Source: Priya Narasimhan, (2006), How To Write a Good (no, Great) PhD Dissertation
Research Visibility and Impact Center-(RVnIC)
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Questions? What is your thesis:

e Research background (Importance/need/rationale)

* Problem statement (Gap analysis (difference between presence and
desired performance)

* Research objectives (Specific, measurable, attainable, realistic,
Time-based)

e Research scope (Area should be covered)

* Research methodology (Steps to achieve objectives)
e Data collection (Why this data, method)

* Analysis (Information generated toward analysis)

e Results and discussions (Drawing conclusions on the objectives)

Research Visibility and Impact Center-(RVnIC)
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What is @ Thesis?

“A thesis is a formal and lengthy
research paper, especially a work of
original research, written in partial
fulfillment of the requirements for a
higher degree in a university”

Source: http://www.awc.metu.edu.tr/handouts/Thesis Writing.pdf



http://www.awc.metu.edu.tr/handouts/Thesis_Writing.pdf

Building the thesis

ili
©2019-2021 Dr. Nader Ale Ebrahim
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Six Rules of Thesis Writing

ldentifying the research problem
Start thesis writing from a day after registration

Writing a Thesis Plan

B w e

Ask your supervisors: What are their
expectations? and maintain regular contact with
your supervisors directly/indirectly

5. Expand networking
Continuously write/revise and Publish



1- Identifying the Research Problem

Researchers begin a study by identifying a research
problem that they need to address. They write
about this “problem” in the opening passages of
their study and, in effect, give you as a reader the
rationale for why the study is important and why
you need to read their study.

Reference: Creswell, J. W. (2012). Educational research: Planning, Conducting, and Evaluating Quantitative and Qualitative Research
(4th ed. ed.). Boston: Pearson Education, Inc.



Link/Educational Research.pdf

2- Start Thesis Writing From a Day After Registration

* Write down a tentative thesis title, even if your
thesis is murky in your mind.

* Write down a first cut at your thesis abstract, even
if you have not done the work yet!

Source: Priya Narasimhan, (2006), How To Write a Good (no, Great) PhD Dissertation

Example

* Write a journal/conference paper while you are
writing the thesis.


Link/Literature Review 13-03-2008.docx

3- Writing a Thesis Plan

* Write down the road-map of your thesis today
 What is the ideal thesis that you would wish for?
* What results would it contain?
 How would you evolve the story from start to finish?

Source: Priya Narasimhan, (2006), How To Write a Good (no, Great) PhD Dissertation

* Write each Chapter of the thesis deliverable items
* Write a checklist for each Chapter
Example 1

Example 2 (thesis checklist)

Research Visibility and Impact Center-(RVnIC)
©2019-2021 Dr. Nader Ale Ebrahim
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Link/Nader Thesis Planning.docx
http://www.owlnet.rice.edu/~cainproj/writingtips/thesischecklist.html
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Year 1
S 6 7 8 9 10 11 12 1 2

read literature

1 2 :3 4

Reading CM = Committee Meeting = time to
refine project plans
Data acquisition  IC = International Conference
Papers
Graduation

Year 3
2 3 4 5 6 7 8 9 10 11 121

Year 2
3 4 56 7 8 9 10 11 121

Year 4
3 4 5 6 7 8 9 10 11 12

perform experiments on main project
c™M
sketch
paper
draft
perform experiments on main project
c™m
. Paper
write main paper reviélan
IC Write thesis Gron

Literature reading is likely to be heavier in the first year but will still be important throughout the doctoral process

Tasks like “perform experiments” were cut in different rows to give a higher sense of flow

The IC is put here at a relative random time to serve as a reminder of something one might want to consider for year 3 or 4
Some tasks can be performed in parallel, like finishing up some experiments while writing a paper
This timeline is only an example and is not designed with any specific project in mind, you will need to adjust it to your specific needs

Source: https://academiac.net/2018/11/20/guidelines-to-draw-a-timeline-of-your-phd/

Research Visibility and Impact Center-(RVnIC)
©2019-2021 Dr. Nader Ale Ebrahim
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Link/PhDTimeline-Academiac.xlsx
https://academiac.net/2018/11/20/guidelines-to-draw-a-timeline-of-your-phd/

4- Ask your supervisors: What are their expectations?

Ask your supervisors for continuous feedback

* Your advisor is your biggest champion, your biggest promoter

* This person wants to see you succeed and will rave about you and your work
enthusiastically to everyone

* Discuss your thesis layout, problem definition, goals of the month, etc.

* For sticky issues, your advisor will find you the right “connections” to fill in the gaps
in your thesis

Source: Priya Narasimhan, (2006), How To Write a Good (no, Great) PhD Dissertation

Keep good relationship with your advisor (even after you graduate).

Source: Useful Things to Know About Ph. D. Thesis Research, by: H.T. Kung , Harvard University

Find a proper Table Of Content (TOC) according to your supervisor

expectation. If you could not find it, follow the following slide
structure:


http://www.eecs.harvard.edu/~htk/thesis.htm

Thesis structure

Materials preceding the text

Title Page

Original Literary Work Declaration
Abstract

Acknowledgements

Table of Contents

List of Figures , List of Tables, List of Symbols and Abbreviations, List of Appendices

The main text

Chapter 1: Introduction

Chapter 2: Literature Review

Chapter 3: Methodology (or Materials and Methods)
Chapter 4: Results (or Experimental Results)

Chapter 5: Discussion

Chapter 6: Conclusion

References and

Appendices

Research Visibility and Impact Center-(RVnIC)
©2019-2021 Dr. Nader Ale Ebrahim
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http://ips.um.edu.my/images/ips/doc/rules_regulations/ips-guide2theses.pdf

4- (Con.) Present your activity indirectly

e Dear Nader Ale Ebrahim:

Your paper, "Virtual R&D Teams in Small and Medium Enterprises: A Literature Review", was recently listed on SSRN's Top Ten
download list for ORG: Contemporary Organizational Structures (Topic) and Structural Dimensions & Organizational Behavior
eJournal. As of 06/16/2010, your paper has been downloaded 107 times. You may view the abstract and download statistics at
http://papers.ssrn.com/abstract=1530904.

Top Ten Lists are updated on a daily basis. Click on the following link to view the Top Ten list for the journal ORG: Contemporary
Organizational Structures (Topic) Top Ten and Structural Dimensions & Organizational Behavior eJournal Top Ten.

Click on the following link to view all the papers in the journal ORG: Contemporary Organizational Structures (Topic) All Papers and
Structural Dimensions & Organizational Behavior eJournal All Papers.

To view any of the Top Ten lists, click the TOP button on any network, sub network, journal or topic in the Browse list reachable
through the following link: http://www.ssrn.com/Browse

Your paper may be listed in the Top Ten for other networks or journals and, if so, you will receive additional notices at that time.

If you have any questions regarding this notification or any other matter, please email AuthorSupport@SSRN.com or call 877-
SSRNHelp (877.777.6435 toll free). Outside of the United States, call 00+1+585+4428170.

* Sincerely,

Michael C. Jensen
Chairman
Social Science Research Network

Research Visibility and Impact Center-(RVnIC)
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http://papers.ssrn.com/abstract=1530904
http://papers.ssrn.com/sol3/topten/topTenResults.cfm?groupingId=1561853&netorjrnl=jrnl
http://papers.ssrn.com/sol3/topten/topTenResults.cfm?groupingId=1561848&netorjrnl=jrnl
http://papers.ssrn.com/sol3/JELJOUR_Results.cfm?form_name=journalBrowse&journal_id=1561853
http://papers.ssrn.com/sol3/JELJOUR_Results.cfm?form_name=journalBrowse&journal_id=1561848
http://www.ssrn.com/Browse
mailto:AuthorSupport@SSRN.com

5- Expand networking

e Vi k&”a.Amidia:_KaM_ .
— 1. Attending conferences for
. o
networking and making contacts

t,, \_ 2. Build an academic network
w around yourself outside your
meu ﬁ_ university

S 3. People should get to know you,

\m not just your advisor

A EL KAMEL

Research Visibility and Impact Center-(RVnIC)
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6- Continuously write/revise and Publish

v'your published papers, as a permanent record of your
research, are your passport to your community

v'Publishing is one of the necessary steps embedded in the
scientific research process. It is also necessary for
graduation and career progression.

v'You need a STRONG manuscript to present your
contributions to the scientific community

Source: How to Write Great Papers, 2012,By: Anthony Newman Publisher, Elsevier, Amsterdam



How not to write a PhD
thesis

Tara Brabazon gives her top
ten tips for doctoral failure

Source: http://www.timeshighereducation.co.uk/news/how-not-to-write-a-phd-thesis/410208.article



http://www.timeshighereducation.co.uk/news/how-not-to-write-a-phd-thesis/410208.article

Top ten tips for doctoral failure

1. Submit an incomplete, poorly formatted bibliography

2. Use phrases such as “some academics” or “all the literature” without mitigating
statements or references

3. Write an abstract without a sentence starting “my original contribution to knowledge
is...”

4. Fill the bibliography with references to blogs, online journalism and textbooks

5. Use discourse, ideology, signifier, signified, interpellation, postmodernism, structuralism,
post-structuralism or deconstruction without reading the complete works of Foucault,
Althusser, Saussure, Baudrillard or Derrida

6. Assume something you are doing is new because you have not read enough to know that
an academic wrote a book on it 20 years ago

7. Leave spelling mistakes in the script
8. Make the topic of the thesis too large
9. Write a short, rushed, basic exegesis

10. Submit a PhD with a short introduction or conclusion
Source: http://www.timeshighereducation.co.uk/news/how-not-to-write-a-phd-thesis/410208.article



http://www.timeshighereducation.co.uk/news/how-not-to-write-a-phd-thesis/410208.article

Tasks for the fifth session

1. Create your own thesis/paper table of contents

2. ldentify the main topics from your collected

documents
3. Create your literature review/Thesis Mind Map

4. Plan your Thesis/Paper writing process
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Thank youl!

Nader Ale Ebrahim, php

Research Visibility and Impact Consultant

E aleebrahim@Gmail.com

a @aleebrahim

P https://publons.com/researcher/1692944
http://scholar.google.com/citations

All of my presentations are available online at:
https://figshare.com/authors/Nader _Ale_Ebrahim/100797
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My recent publication:

1. A. Ghanbari Baghestan, H. Khaniki, A. Kalantari, M. Akhtari-Zavare, E. Farahmand, E. Tamam, N. Ale Ebrahim, H. Sabani, and M.
Danaee, (2019) “A Crisis in “Open Access”: Should Communication Scholarly Outputs Take 77 Years to Become Open Access?,”
SAGE Open, vol. 9, no. 3, pp. 1-8,

2. Ale Ebrahim, S., Ashtari, A., Pedram, M. Z., & Ale Ebrahim, N. (2019). Publication Trends in Drug Delivery and Magnetic
Nanoparticles. Nanoscale Research Letters, 14(59). doi: https://doi.org/10.1186/s11671-019-2994-y

3. Parnianifard, A., Azfanizam, A., Ariffin, M., Ismail, M., & Ale Ebrahim, N. (2019). Recent developments in metamodel based
robust black-box simulation optimization: An overview. Decision Science Letters, 8(1), 17-44. doi:10.5267/.dsl.2018.5.004.
Available at SSRN: https://ssrn.com/abstract=3192794

4. Elaish, M. M., Shuib, L., Ghani, N. A., Mujtaba, G., & Ale Ebrahim, N. (2019). A Bibliometric Analysis of M-Learning from Topic
Inception to 2015. International Journal of Mobile Learning and Organisation, 13(1), 91-112.
https://doi.org/10.1504/1JML0O.2019.096470

5. Nordin, N., Samsudin, M.-A., Abdul-Khalid, S.-N., & Ale Ebrahim, N. (2019). Firms’ sustainable practice research in developing
countries: Mapping the cited literature by Bibliometric analysis approach. International Journal of Sustainable Strategic
Management, 7(1/2). doi:. https://doi.org/10.1504/1JSSM.2019.099036

My recent presentations:

1. Ale Ebrahim, Nader (2019): Research Skills Session 4: Evaluate a paper quality. figshare. Presentation.
https://doi.org/10.6084/m9.figshare.10032167.v1

2. Ale Ebrahim, Nader (2019): Research Skills Session 3: Finding Research Papers. figshare. Presentation.
https://doi.org/10.6084/m9.figshare.9993059.v1

3. Ale Ebrahim, Nader (2019): Research Skills Session 2: Selecting keywords. figshare. Presentation.
https://doi.org/10.6084/m9.figshare.9946706.v1

4. Ale Ebrahim, Nader (2019): Research Skills Session 1: Introduction. figshare. Presentation.
https://doi.org/10.6084/m9.figshare.9931163.v1

5. Ale Ebrahim, Nader (2019): Introduction to “Research Tools”: Tools for Collecting, Writing, Publishing, and Improving Research
Visibility. figshare. Presentation. https://doi.org/10.6084/m39.figshare.8258957.v1
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